When you use metallic silver ink and white ink, be sure to read this first.

This document describes the characteristics of special color inks (white ink and metallic silver ink) for VS-640/540/420/300, the important notes on the usage of these inks, and the maintenance and printing method in using these inks. For other information, refer to the VS-640/540/420/300 Setup Guide and User’s Manual.
Thank you very much for purchasing this product.

- To ensure correct and safe usage with a full understanding of this product’s performance, please be sure to read through this manual completely and store it in a safe location.
- Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.
- The contents of this operation manual and the specifications of this product are subject to change without notice.
- The operation manual and the product have been prepared and tested as much as possible. If you find any misprint or error, please inform us.
- Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of this product, regardless of any failure to perform on the part of this product.
- Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to any article made using this product.
# Contents

Contents ........................................................................................................................................... 1

**Chapter 1 Getting Started** ........................................................................................................ 3

1-1 What This Document Assumes and Related Manuals ..................................................... 4
  What This Document Assumes .................................................................................................... 4
  Related Manuals ......................................................................................................................... 4
  VersaWorks Online ..................................................................................................................... 4

1-2 Before Starting Operations .................................................................................................. 5
  Important: Characteristics of Inks and Important Notes ......................................................... 5
  Before Starting the Day's Work ................................................................................................. 5

1-3 Important Notes on Printing ................................................................................................. 6
  Using the Middle Pinch Rollers in Printing and Cutting .......................................................... 6
  Important Notes in Using Transparent Media ........................................................................ 6
  Important Notes on Using Media Take-up System ................................................................. 6

**Chapter 2 Getting Ready** ........................................................................................................ 7

2-1 Preparing VersaWorks ........................................................................................................ 8
  Starting VersaWorks .................................................................................................................. 8
  Creating a Folder for Saving PS Files ....................................................................................... 8

2-2 Printer Preparations ............................................................................................................ 9
  Making the Printer Settings and Loading Media .................................................................... 9

2-3 Creating Printing Data ......................................................................................................... 10
  Basic Approach for Creating Printing Data ............................................................................ 10
  Creating Data for Printing ........................................................................................................ 10
  Blend Print and Layered Print (Metallic Silver and CMYKLcLm) ........................................... 16

**Chapter 3 Printing** .................................................................................................................. 19

3-1 Print Job Setting .................................................................................................................. 20
  Printing Only with Metallic Silver Ink ..................................................................................... 20
  Blend Print (Metallic Silver + CMYKLcLm) ............................................................................. 22
  Layered Print (Metallic Silver ☻ CMYKLcLm) ........................................................................ 24
  Layered Print (CMYKLcLm ☻ Metallic Silver) ...................................................................... 26
  Printing Only with White Ink .................................................................................................. 28
  Printing with White, Metallic Silver, and CMYK Ink ............................................................... 30
  Printing with White and CMYKLcLm Ink .............................................................................. 33

3-2 Starting the Print Operation ................................................................................................. 35
  Starting the Print Operation ..................................................................................................... 35
  Printing a Metallic Color Chart ............................................................................................... 36

**Chapter 4 Advanced** .............................................................................................................. 39

4-1 Performing Texture Printing ............................................................................................... 40
  What is Texture Printing? ......................................................................................................... 40
  Create The Texture Printing Data ........................................................................................... 40
  Performing Texture Printing ................................................................................................... 45
  Printing a Texture Chart .......................................................................................................... 46
Chapter 5 Maintenance .................................................................49

5-1 Maintenance ...........................................................................50
  Message for Ink Circulation ..............................................................50
  When Dot Drop-out Etc. Cannot be Corrected ................................50
Chapter 1
Getting Started

1-1 What This Document Assumes and Related Manuals ..........4
  What This Document Assumes ...................................................4
  Related Manuals ..........................................................................4
  VersaWorks Online ......................................................................4
1-2 Before Starting Operations ......................................................5
  Important: Characteristics of Inks and Important Notes ..............5
  Before Starting the Day’s Work ...................................................5
1-3 Important Notes on Printing .....................................................6
  Using the Middle Pinch Rollers in Printing and Cutting ...............6
  Important Notes in Using Transparent Media ..............................6
  Important Notes on Using Media Take-up System ......................6
1-1 What This Document Assumes and Related Manuals

What This Document Assumes

Before performing any operations described in this guide, make sure that all the following preparations have been complete.

- Assembling and installing the VS-640/540/420/300 (it is called, “This machine” at the following) unit
- Installing VersaWorks on your computer, and connecting the computer to this machine via a network

Related Manuals

Read the following documentation for information about setting up this machine and VersaWorks.

1. **Setup Guide**
   This manual covers details about how to use this machine, including how to set up the printer and where to locate the printer, etc. Be sure to read this manual.

2. **User’s Manual**
   This manual describes operation methods in detail. After you have read Setup Guide, be sure to read this manual.

3. **VersaWorks Quick Start Guide**
   Chapter 1 of this manual, “Setting for VersaWorks,” provides you with instructions necessary to perform printing with VersaWorks, including how to install the software. Be sure to read this chapter following the above “User’s Manual.”
   You are also recommended to read Chapter 2, “Getting Started,” to become familiar with how to use this program.

VersaWorks Online

This document describes the important notes to use the metallic silver ink and white ink as well as the basic printing method using these inks. You can get the latest information about Roland VersaWorks and the information on printing methods requiring more complex settings by viewing VersaWorks Online. If you want to learn more about the features of Roland VersaWorks, or if you want to use metallic silver ink and white ink more effectively, be sure to visit VersaWorks Online.


VersaWorks Online can be displayed by clicking [help] - [VersaWorks Online] from the main menu.
1-2 Before Starting Operations

Important: Characteristics of Inks and Important Notes

The usage and handling of white ink and metallic silver ink involve some important considerations that do not apply to ink of other colors. Be sure to familiarize yourself with the characteristics of the inks before you use them.

**White ink and metallic silver ink precipitate.**

- If they are allowed to stand, the precipitates in them may solidify and cause clogging of the print heads or other malfunction. Be sure to observe the cautions in this manual.

**Maintenance must be performed.**

- Always keep the main power switched on. If the main power is switched off, the automatic maintenance function stops working, and it may result in malfunction.
- We recommend that you operate the printer at least once a week.
- If the printer is left unused for a long period of time, ink precipitation may occur, causing unstable ink discharge, which may result in dot drop-out, etc. In such cases, the precipitated and solidified ink needs to be cleared.
  - P. 50, "When Dot Drop-out etc. cannot be corrected"

**Drying inks**

- After output, allow the ink to dry sufficiently. Note that white ink and metallic silver ink in particular require printing at a high density, and so are more difficult to dry than CMYKLCm inks.

**We strongly recommend lamination.**

- Depending on conditions, the weatherability of metallic silver ink and white ink may be inferior to that of CMYKLCm inks. Therefore, laminating is strongly recommended.

**Before Starting the Day’s Work**

- Remove just the white and metallic silver ink cartridges, shake them gently, then reinsert them.
- You do not have to shake the cyan, magenta, yellow, black, light-cyan, and light-magenta ink cartridges every day, but be sure to shake them when you install new cartridges for these colors.

The ingredients in white and metallic silver inks tend to settle. Each day, before starting the day’s operations, be sure to carry out the above steps. Allowing the ink to stand without carrying out these steps can cause the settled material to harden, resulting in malfunction or other problems.
1-3 Important Notes on Printing

Using the Middle Pinch Rollers in Printing and Cutting

Since metallic silver ink and white ink are difficult to dry, the middle pinch rollers will smudge the printed surface when printing and cutting are performed. Thus, when you perform printing and cutting using metallic silver ink and/or white ink, secure the media in place using only two pinch rollers on the right and the left. However, some types of the media may partially float and it may cause bad effect on printing, feeding and/or cutting. Use the media after confirmation of the nature of your media.

Important Notes in Using Transparent Media

Loading transparent media

- Set the [EDGE DETECTION] menu item to "DISABLE". Transparent media cannot be loaded unless this setting is made.
- Ensure a margin of at least 75 mm from the leading edge of the media to the printing- or cutting-start location.

Important notes on the amount of media remaining

- When you use transparent media, the presence of media cannot be detected. In such cases, printing operation does not stop when the media runs out, and there is a chance that the platen or the like may become soiled with ink or that ink may get inside and damage the machine. If media runs out while printing is in progress, immediately press \( \text{PAUSE} \) to stop printing.

Using the middle pinch rollers

- The middle pinch rollers scratch media slightly, and on transparent media such scratches can be very noticeable. Also, the middle pinch rollers will smudge the printed surface when transparent media is pulled back after printing. When you use transparent media, secure the media in place using only two pinch rollers on the right and the left.

Automatic crop-mark detection

- Automatic crop-mark detection does not work with transparent media. In such cases, perform alignment manually.
  - "User’s Manual"

Important Notes on Using Media Take-up System

Since metallic silver ink and white ink are difficult to dry, if you use the media take-up system (at your option), media and/or the printed surface may be smudged depending on the type of media you use. If you use the media take-up system leaving the middle pinch rollers removed, some types of the media may not be taken up normally and/or cause bad effect on printing, feeding and/or cutting quality as well as partial float of the media. Be sure to use the media take-up system on confirmation of the nature and compatibility of your media.
Chapter 2
Getting Ready

2-1 Preparing VersaWorks ............................................................ 8
   Starting VersaWorks .................................................................. 8
   Creating a Folder for Saving PS Files ........................................ 8

2-2 Printer Preparations ............................................................... 9
   Making the Printer Settings and Loading Media ....................... 9

2-3 Creating Printing Data ........................................................... 10
   Basic Approach for Creating Printing Data ............................... 10
   Creating Data for Printing ....................................................... 10
   Blend Print and Layered Print .................................................. 10
   (Metallic Silver and CMYKLcLm) .............................................. 16
Starting VersaWorks

On the computer you are using, start VersaWorks. For information on how to start the program, see the Roland VersaWorks Quick Start Guide. After starting the program, go to the upper left of the main screen and check to make sure that "Model (or Nickname) of Your Printer" is displayed, and that "Status" is set to "Ready to Print."

Creating a Folder for Saving PS Files

Before you actually print an image you draw using application software such as Adobe Illustrator, it is necessary to save the image as a PS file(s). And then, you can print the image by loading the PS file(s) on VersaWorks. Because of this, you should create a folder for saving PS files in advance. It is recommended to locate the folder in the root directory on your computer’s local disk.

Procedure

1. **Open [Computer] ( or [My Computer]), and then open [Local Disk (C:)])**.

2. On the [Organize] menu, click [New Folder].

3. Enter the name for the folder, and then press the Enter key.

   Here you name the folder "MT-WH_print", for example.
## 2-2 Printer Preparations

### Making the Printer Settings and Loading Media

#### When Using Transparent Media

When you are using transparent media, make the necessary printing settings on the printer and load the media accordingly.

**Procedure**

1. Press \( \text{MENU} \) and make the following settings.
   - [EDGE DETECTION] to "DISABLE."

2. **Load transparent media into the printer.**
   - When the media warps or partially floats, ensure a margin of about 200 mm from the leading edge of the media to the printing- or cutting-start location.
   - Be sure to use the media clamps when you load media.

#### When Using Media Other Than Transparent Media

Load the media using the method described in the User's Manual.
Basic Approach for Creating Printing Data

When you’re printing using metallic silver ink and/or white ink, you create the printing data using a spot color.

**when Using Metallic Silver Ink**

When you print using metallic silver ink, you can create the printing data according to the two methods below.

- Specify the spot color so as to use only the metallic silver ink.
  Specify the spot color named “RDG_MetallicSilver” to the areas you want to print using the metallic silver ink.

- Specify the spot color from the exclusive metallic color special colors library.
  From the exclusive metallic color special colors library, select the special metallic color (spot color) to be used which is the combination color of CMYKLCm ink and metallic silver ink.

**When Using White Ink**

Specify the spot color named "RDG_WHITE" to the areas you want to print using the white ink.

Creating Data for Printing

Create the data for printing using the metallic silver ink and white ink. The program used to create the printing data is Adobe Illustrator CS3, in this section. For detailed information on drawing methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator CS3. If you are using another version of Adobe Illustrator, operations may be somewhat different from those explained here.

1. **Open the exclusive swatch library.**

   At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
   The “Select Library” window appears.
   The swatch palette is displayed by going to the menu, selecting [Window], and then selecting [Swatch].
2 ① Open folders in the order of [Computer] (or [My Computer]) → [Local Disk (C:)] → [Program Files] → [Roland VersaWorks] → [Swatch] → [Illustrator], then select "Roland VersaWorks.ai"
Depending on the settings of your computer, the extension ".ai" might not be shown.

② Click [Open].
The swatch library containing "RDG_MetallicSilver" and "RDG_WHITE" is displayed.

3 ① Open the same folders as in step ②, and then select "Roland Metallic Color System Library.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown.

② Click [Open].
The swatch library is displayed which is containing the "metallic color" created by mixing the metallic silver ink and CMYKLCm ink.

Tips!
By saving the ".ai" file selected in steps ② and ③ into the folder below, you can register each swatch library to the Adobe Illustrator's library.
C:\Program Files\Adobe\Adobe Illustrator CS3\Presets\Swatch ("C" is the name of your computer's local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, eliminating the need to search the file every time you start Adobe Illustrator.
2. Create the illustration, and specify the spot color that matches the color you want to print.

1. **Create the illustration.**
   Be sure to draw the illustration in the CMYK mode.

2. **Specify each spot color that matches the color you want to print.**

<table>
<thead>
<tr>
<th>Desired ink or color</th>
<th>Spot color name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metallic silver ink</td>
<td>RDG_MetallicSilver</td>
</tr>
<tr>
<td>White ink</td>
<td>RDG_WHITE</td>
</tr>
<tr>
<td>Metallic color</td>
<td>RVW-MT-Silver, RVW-MT-Bronze, RVW-MT-TitanBlack, etc.</td>
</tr>
</tbody>
</table>

**POINT!**

Using the metallic silver ink, you can perform the blend print and the layered print by combining the ink with the CMYKLcLm ink.

☞ P. 16, “Blend Print and Layered Print (Metallic Silver and CMYKLcLm)”
3. Create the PS (PostScript) file.

① Select [Print] from the [File] menu.

② Select [Roland VW].
When a nickname is set, or when more than one printer is connected, select “Roland VW_(the nickname of the printer used for output).”

③ Click [Setup].

④ Click [Continue].
1. Turn on the [Print to file] option.

2. Click [Preferences].

3. Click [Advanced] in the [Layout] tab. For Windows 2000: In the "Print" dialog box (the window at the very top of this page), go to the "Layout" tab and click [Advanced].

4. Click the down arrow to the right of the [Paper Size] box, and then click [PostScript Custom Page Size] from the list that appears.

5. For "Custom Page Size Dimensions," enter the values in the "Width" and "Height" fields. Enter values for the same size as the illustration you created in step 2.

4. Click [Print].
   - Click [Print].

5. Specify the destination and file name for saving.
   - Example: "C:\MT-WH_print" for the folder to save to, and "mt-wh.ps" as the file name.
   - Click [Save].
   - The CMYK layer of the image is saved as a PS file.

   Assign the name you want. It may be a good idea to assign a name that indicates that the file uses white and metallic silver ink.

6. Open the folder you saved to and make sure the file has been created.
Blend Print and Layered Print (Metallic Silver and CMYKLcLm)

Using the metallic silver ink, you can perform the blend print and the layered print by combining the ink with the CMYKLcLm ink. By this means, you can realize the metallic expressions that cannot be made only with the CMYKLcLm ink. The printing methods are different between the blend print and the layered print, and so are the metallic impressions of the CMYKLcLm colors. Select and use the types of printing to suit your taste.


* When you perform “Printing with White, Metallic Silver, and CMYK Ink” (page 30), the printing method is limited to the blend print.

**POINT!**

In performing the blend print or the layered print, you can specify the colors from the metallic color special colors library. However, if you specify the metallic colors with the same names for the blend print and the layered print, the tones of the colors are different between them. We recommend that you check the tones of the colors by performing the test printing or printing out the Metallic Color Chart.

Seeing the metallic color chart for the layered print, you may feel a slight inconsistency between the names and the tones of the colors. This is because the colors listed in the Metallic Color Chart are named based on those for the blend print.

- P. 36, “Printing a Metallic Color Chart”

Blend Print

(Image of printing method)
Layered Print

(Image of printing method)

The metallic silver ink and the CMYKLcLm ink are separated into the different layers and printed in that order. (Metallic silver ink \(\rightarrow\) CMYKLcLm ink)

The printed image is to be seen from this side (the printed surface of the finished results).

The metallic silver ink and the CMYKLcLm ink are separated into the different layers and printed in that order. (CMYKLcLm ink \(\rightarrow\) Metallic silver ink)

The printed image is to be seen from this side (the opposite side of the printed surface of the finished results).
Chapter 3
Printing

3-1 Print Job Setting .................................................................20
  Printing Only with Metallic Silver Ink ........................................20
  Blend Print (Metallic Silver + CMYKcLm) ..............................22
  Layered Print (Metallic Silver ⇒ CMYKcLm) .........................24
  Layered Print (CMYKcLm ⇒ Metallic Silver) .........................26
  Printing Only with White Ink ................................................28
  Printing with White, Metallic Silver, and CMYK Ink .................30
  Printing with White and CMYKcLm Ink .................................33

3-2 Starting the Print Operation ................................................35
  Starting the Print Operation ................................................35
  Printing a Metallic Color Chart ............................................36
3-1 Print Job Setting

Printing Only with Metallic Silver Ink

This section describes how to perform printing only with the metallic silver ink. To use the metallic silver ink in printing, you need to use the printing data where the use of the metallic silver ink is designated. If the printing data have the portion designating the use of other colors, with the settings described in this section, you can print with the metallic silver ink only the area of the image which has been designated to print with the metallic silver ink.

☞ P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (☞ page 7, “Chapter 2 -- Getting Ready”).

2. Double-click .
   Queue A Properties” window appears.

3. Click .

   For [Media Type], select names with [MT] attached such as "Generic Vinyl 1 [MT]". Make the selection that matches the media to be used. Selecting an item attached with [MT] enables you to choose the print mode that can use the metallic silver ink.

   For [Print Quality], select [High Quality]

   For [Mode], select [MetallicSilver (v)].
Click .

Turn on the [Convert Spot Color] option.

Click .

In [Operation Mode], select the operation of the printer.

Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, go on to page 35 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, refer to the online help provided for VersaWorks.

* If you select [CMYKLcLm (v)] for [Mode] in the procedure 3, only the area of the image where CMYK is specified in the printing data is to be printed.
Blend Print (Metallic Silver + CMYKLcLm)

This section describes how to perform the blend print with the metallic silver ink and CMYKLcLm ink.

P. 16, “Blend Print and Layered Print (Metallic Silver and CMYKLcLm)"

To perform the blend print, you need to use the printing data where the use of the metallic silver ink and the CMYKLcLm ink is designated.

P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (P. 7, “Chapter 2 -- Getting Ready”).

2. Double-click .

   Queue A Properties” window appears.

3. Click .

   For [Media Type], select names with [MT] attached such as “Generic Vinyl 1 [MT]”. Make the selection that matches the media to be used. Selecting an item attached with [MT] enables you to choose the print mode that can use the metallic silver ink.

   For [Print Quality], select [High Quality].

   For [Mode], select [CMYKLcLmMt (v)].
3-1 Print Job Setting

4. Click . Turn on the [Convert Spot Color] option.

5. Click . In [Operation Mode], select the operation of the printer.

6. Click [OK] to close the "Queue A Properties" window.

This is the end of the print job setting. To start printing, go on to page 35 "Starting the Print Operation."

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
Layered Print (Metallic Silver ⇒ CMYKLCm)

This section describes how to perform the layered print with the metallic silver ink and CMYKLCm ink using the metallic silver ink as background.

To perform the layered print, you need to use the printing data where the use of the metallic silver ink and the CMYKLCm ink is designated.

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (page 7, “Chapter 2 -- Getting Ready”).

2. Double-click .
Queue A Properties” window appears.

3. Click .

For [Media Type], select names with [MT] attached such as "Generic Vinyl 1 [MT]".
Make the selection that matches the media to be used. Selecting an item attached with [MT] enables you to choose the print mode that can use the metallic silver ink.

For [Print Quality], select [High Quality (Layerd)].
If [Mode] is selectable, select [Mt ⇒ CMYKLCm (v)].
3-1 Print Job Setting

4. Click .

Turn on the [Convert Spot Color] option.

5. Click .

In [Operation Mode], select the operation of the printer.

6. Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, go on to page 35 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
Layered Print (CMYKLC\(\text{Lm} \Rightarrow \text{Metallic Silver}\))

This section describes how to perform the layered print with the metallic silver ink and CMYKLC\(\text{Lm}\) ink using the CMYKLC\(\text{Lm}\) ink as background.

- P. 16, “Blend Print and Layered Print (Metallic Silver and CMYKLC\(\text{Lm}\))”

To perform the layered print, you need to use the printing data where the use of the metallic silver ink and the CMYKLC\(\text{Lm}\) ink is designated.

- P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (☞ page 7, “Chapter 2 -- Getting Ready”).

2. Double-click .
   Queue A Properties” window appears.

3. Click .
   For [Media Type], select “xxx[MT]: Clear PET Film” or “xxx[MT]: PET Clear Film, Adhesive” (or xxx: Clear PET Film, “xxx: PET Clear Film, Adhesive).
   * “xxx” indicates “ESP-CL” and others.

   For [Print Quality], select [High Quality (Layerd)].
   For [Mode], select [CMYKLC\(\text{Lm} \Rightarrow \text{Mt (v)}\)].
3-1 Print Job Setting

4  Click .

Turn on the [Convert Spot Color] option.

5  Click .

In [Operation Mode], select the operation of the printer.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

Click .

Turn on the [Mirror] option.
When the printing data with mirror image is prepared beforehand, you do not need to turn on this option.

6  Click [OK] to close the "Queue A Properties" window.

This is the end of the print job setting. To start printing, go on to page 35 "Starting the Print Operation."

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
Printing Only with White Ink

This section describes how to perform printing only with the white ink. To use the white ink in printing, you need to use the printing data where the use of the white ink is designated. If the printing data have the portion designating the use of other colors, with the setting described in this section, you can print with the white ink only the area of the image which has been designated to print with the white ink.

☞ P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (☞ page 7, “Chapter 2 -- Getting Ready”).

2. Double-click .

   Queue A Properties” window appears.

3. Click .

   For [Media Type], select “xxx[MT]: Clear PET Film” or “xxx[MT]: PET Clear Film, Adhesive” (or xxx: Clear PET Film,” “xxx: PET Clear Film, Adhesive).

   * “xxx” indicates “ESP-CL” and others.

   For [Print Quality], select [High Quality].

   When “xxx: Clear PET Film” or “xxx: PET Clear Film, Adhesive” is selected for [Media Type], [Print Quality] need not be selected (because the option is only [High Quality]).

   For [Mode], select [White (v)].
3-1  Print Job Setting

4 Click .

Turn on the [Convert Spot Color] option.

5 Click .

In [Operation Mode], select the operation of the printer.

6 Click [OK] to close the "Queue A Properties" window.

This is the end of the print job setting. To start printing, go on to page 35 "Starting the Print Operation."

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
Printing with While, Metallic Silver, and CMYK Ink

This section describes how to perform printing with the metallic silver ink, the white ink, and the CMYK ink. Deciding which ink between the white and the others (the metallic silver and CMYK) you want to use for the base is an important point in determining the print job setting here. To use the metallic silver ink and the white ink, you need to use the printing data where the use of the respective inks is designated. For the area of the image to be printed with the metallic silver ink and the CMYK ink combined, the setting is fixed to the blend print.

☞ P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (☞ page 7, “Chapter 2 -- Getting Ready”).


3. Click .

For [Media Type], select “xxx[MT]: Clear PET Film” or “xxx[MT]: PET Clear Film, Adhesive.”

* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Quality]. With [Mode], select the print mode. White → CMYKMt (v) Inks are overprinted in the sequence of white and then metallic silver/CMYK Color. CMYKMt → White (v) Inks are overprinted in the sequence of white and then metallic silver/CMYK Color.
Image of overprinting in the sequence of white and then metallic silver/CMYK Color
(Print Mode "White -> CMYKMt (v)")

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are shown here as separate layers in order to indicate the printing sequence.

Image of overprinting in the sequence of metallic silver/CMYK Color and then white
(Print Mode "CMYKMt -> White (v)")

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are shown here as separate layers in order to indicate the printing sequence.
Click .

Turn on the [Convert Spot Color] option.

Click .

In [Operation Mode], select the operation of the printer.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

Click .

Turn on the [Mirror] option.
When the printing data with mirror image is prepared beforehand, you do not need to turn on this option.

Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, go on to page 35 “Starting the Print Operation.” Only the settings necessary for the use of the metallic silver ink and white ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
3-1 Print Job Setting

Printing with White and CMYKlcLm Ink

This section describes how to perform printing with the white ink and the CMYKlcLm ink. Deciding which ink between the white and the CMYKlcLm you want to use for the base is an important point in determining the print job setting here. To use the white ink for printing, you need to use the printing data where the use of the white ink is designated.

☞ P. 10, “2-3 Creating Printing Data”

Procedure

1. Make sure that you have finished making the preparations for VersaWorks, getting the printer ready, and creating the printing data (☞ page 7, “Chapter 2 -- Getting Ready”).


3. Click .

For [Media Type], select “xxx: Clear PET Film” or “xxx: PET Clear Film, Adhesive.” “xxx” indicates “ESP-CL” and others.

With [Mode], select the print mode.

- **White -> CMYKlcLm (v)**
  Inks are overprinted in the sequence of white and then CMYKlcLm Color.
- **CMYKlcLm -> White (v)**
  Inks are overprinted in the sequence of CMYKlcLm and then white Color.

* The image of overprinting in the sequence of white and CMYKlcLm is the same as that of overprinting in the sequence of white and metallic silver/CMYK on page 31. (The description of “metallic silver/CMYK” is to be replaced with “CMYKlcLm” only.)
3-1 Print Job Setting

4. Click 

Turn on the [Convert Spot Color] option.

5. Click 

In [Operation Mode], select the operation of the printer.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film. 

P. 32

6. Click [OK] to close the “Queue A Properties” window.

This is the end of the print job setting. To start printing, go on to page 33 “Starting the Print Operation.” Only the settings necessary for the use of the white ink are described in this section. For other settings, refer to the online help provided for VersaWorks.
Chapter 3  Printing

Starting the Print Operation

Following the print job setting, you can start the print operation.

Procedure

1. **Make settings for the print job.**
   - P. 20, “3-1 Print Job Setting”

2. Go to “Job List,” click the “Queue A” tab, and drag the printing data to the queue A job list (If the print job setting has been made in [Queue B], drag and drop the printing data on the job list of [Queue B]).

   The contents of the data are displayed in the preview window, and the layout on the media is displayed in the layout window.

   Areas using “RDG_MetallicSilver” or special metallic color (RVW-MT-Bronze, etc.) are displayed with shading in transparent gray.

   Areas using “RDG_WHITE” are displayed with shading in transparent magenta.
3-2 Starting the Print Operation

Select the print job in the job list, and then click ✴. Printing will be started.

Tips!
After printing, allow the ink to dry sufficiently. We strongly recommend performing lamination.

Tips!
To continue printing similar data, repeat steps 2 and 3. Also, if you want to modify detailed settings for each job, it will be convenient to perform modifications in the “Job Setting” window (which you can display by double-clicking the print job in the job list).

Printing a Metallic Color Chart

The Metallic Color Chart is the printing sample of the special metallic color. By printing the Metallic Color Chart, you can confirm the “complete metallic color chart” representing the special metallic color itself that can be printed with “Your Printer” and “Your Media” (slight pattern differences is possible to occur depending on the conditions of the printer and media.) By selecting colors from this color chart and creating illustrations with these colors, you can accurately reproduce the desired colors.

Procedure

1 Make sure that you have finished making the preparations for VersaWorks, and getting the printer ready (→ page 7, “Chapter 2 -- Getting Ready”).

2 Double-click ✴. Queue A Properties” window appears.
3-2 Starting the Print Operation

3. Click , configure the settings in [Quality-Settings] and [Color Management].
   ➥ P. 20, “3-1 Print Job Setting”

   ① Click [OK].

   POINT!

   When printing a Metallic Color Chart, the [Quality] settings from the [Queue Properties] window are always applied. Since you cannot change the quality settings for the job using the [Job Settings] window after it has been added, be sure to configure the settings in the [Queue Properties] window before performing the following operations.

4. ① Click [Media] and then [Metallic Color Chart].

   ② Check the page size.
   If the size of the media loaded on the printer is not adequate for the page size, change it to another media of sufficient size.

   ③ Click [OK].
   The print job of the Metallic Color Chart is added to the job list.

5. Click .
   Printing will be started.
Chapter 4
Advanced

4-1 Performing Texture Printing ..................................................40
  What is Texture Printing? .........................................................40
  Create The Texture Printing Data ...............................................40
  Performing Texture Printing ....................................................45
  Printing a Texture Chart .........................................................46
4-1 Performing Texture Printing

What is Texture Printing?

Texture printing is a printing method to produce texture patterns. This uses the texture patterns of the exclusive library to create and output the printing data. This document describes the texture printing using metallic silver ink.

* Create the printing data using the Adobe Illustrator version of CS or later if using Adobe Illustrator. If you use the earlier version before Adobe Illustrator 10 to create the printing data, the texture patterns may result in poor condition.

Create The Texture Printing Data

To create the data for the texture printing, please follow the instructions below.
The program used to create the printing data is Adobe Illustrator CS4. For detailed information on drawing methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator CS4. If you’re using another version of Adobe Illustrator, operations may be somewhat different from those explained here.

1. Open the exclusive library.

   At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.

   * The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].
Performing Texture Printing

Chapter 4  Advanced

1. Open folder in the order of [Computer] (or [My Computer]) → [Local Disk (C:)]) → [Program Files] → [Roland VersaWorks] → [Swatch] → [Illustator], and then select “Roland Metallic Texture System Library.ai.” Depending on the settings of your computer, the extension “.ai” might not be shown.

2. Click [Open].

The exclusive swatch libraries “Roland Metallic Texture System Library.ai” is displayed.

Tips!
By saving the “.ai” file selected in step 2 into the folder below, you can register the exclusive library to the Adobe Illustrator’s library.
C:\Program Files\Adobe\Adobe Illustrator CS4\Presets\Swatch (“C” is the name of your computer’s local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, eliminating the need to search the file every time you start Adobe Illustrator.
2. Create Illustrations and Specify Texture Patterns You Wish to Use

1. Create the illustration.
   Be sure to draw the illustration in the CMYK mode.

2. Assign the desired texture patterns to the areas for the texture printing.
   The areas where the texture patterns are assigned shall be printed with metallic silver ink. When the metallic silver ink is to be used for the printings other than the texture printing, other special spot colors shall be used. For the detailed usage, please refer to “Chapter 2 Getting Ready”.

   ![Illustration of Grape Soda with texture pattern]

* The name of the texture pattern is displayed on the data of Illustrator. The texture of the displayed image appears rougher than that of the actual print.
3. Create the PS (PostScript) file.

① Click [Print] from the [File] menu.
② Select [Roland VW].
③ Click [Setup].
④ Click [Continue].
Performing Texture Printing

1. Turn on the [Print to file] option.

2. Click [Preferences].

3. Click [Advanced] in the [Layout] tab. For Windows 2000: In the "Print" dialog box (the window at the very top of this page), go to the "Layout" tab and click [Advanced].

4. Click the down arrow to the right of the [Paper Size] box, and then click [PostScript Custom Page Size] from the list that appears.

5. For "Custom Page Size Definition," enter the values in the "Width" and "Height" fields.
Enter values for the same size as the illustration you created in step 2.

4-1 Performing Texture Printing

1. Click [Print].
2. Click [Print].

Specify the destination and file name for saving, then save the file.
Example: "TEX_print" for the folder to save to, and "tex.ps" as the file name.

3. Click [Save].
The CMYK layer of the image is saved as a PS file.

5. Open the folder you saved to and make sure the file has been created.

Performing Texture Printing

Procedure

1. Prepare the printing data having been created in the previous process which is described in “Create The Texture Printing Data” on page 40.
Make the setting to output metallic silver ink with the VersaWorks, and execute the printing.

To use metallic silver ink, you need to select "CMYKMt" or "CMYKLcLmMt" in the print mode of the VersaWorks. For the detailed method of setting, please refer to "Chapter 3 Printing".

**Printing a Texture Chart**

The texture chart is the printing sample of the texture pattern. By printing the texture chart, you can confirm the "complete texture chart" representing the texture itself that can be printed with "Your Printer" and "Your Media" (slight pattern differences is possible to occur depending on the conditions of the printer and media.) By selecting a pattern from this texture chart and creating the printing data using that selected pattern, you can print your intended pattern almost perfectly. (The procedure is explained using the windows of the VS-640.)

**procedure**

1. Double-click .
   The [Queue A Properties] window appears.

2. Click , configure the settings in [Quality Settings] and [Color Management].

3. Click [OK].

Note: When printing a texture chart, the [Quality] settings from the [Queue Properties] window are always applied. Since you cannot change the quality settings for the job using the [Job Settings] window after it has been added, be sure to configure the settings in the [Queue Properties] window before performing the following operations.
Click [Chart] under [Print Roland Texture System Library] form the [Media] menu. This message appears: The following job will be printed. Do you want to continue? Check that the media in the printer is large enough for the displayed page size.

Click [OK]. The texture chart is added to the job list.

Click [Chart]. Rip'ing and printing the texture chart are performed.

* In the texture chart, color is added to part of the background of the texture. This makes the design of the texture clear.
Chapter 5
Maintenance

5-1 Maintenance .................................................................50
Message for Ink Circulation..............................................50
When Dot Drop-out Etc. Cannot be Corrected...............50
5-1 Maintenance

Message for Ink Circulation

With this machine, white ink and metallic silver ink are circulated periodically to prevent the ink precipitation. When the following message appears, please wait until the display changes.
[CIRCULATING INK]

In order to allow the automatic maintenance such as above to be performed, please observe the items below.
➢ Leave the main power on at all times.
➢ Never leave the front cover open for long periods.
➢ After making the settings for the various menu items, go back to the top screen.

When Dot Drop-out Etc. Cannot be Corrected

When using metallic silver ink and white ink, ink discharge may become unstable (resulting in dot drop-out, etc.) if the machine is left unattended for a long period. This is due to the properties of metallic silver ink and white ink containing ingredients which tend to settle and separate, which will cause the precipitated ingredients to solidify when the machine is left unattended for a long period. In such cases, perform "ink renewal" menu.

For information on how to operate the "ink renewal" menu, refer to the User’s Manual.

➢ “User’s Manual” ("When Problems Such As Dot Drop-out are not cleared up")

If the problems, such as dot drop-out, cannot be corrected even after performing cleaning above, then contact your authorized Roland DG Corp. dealer or us.